.

S| HYSITRON

[

Pl 95 TEM Picolndenter User Manual

Revision 9.2.1211

JEOL TEM Models




Ol
IS - YSITRON

Revision 9.2.1211

This user manual as well as the software described in it, is furnished under license and
may only be used or copied in accordance with the terms of the license. The
information in this manual is furnished for informational use only, is subject to change
without notice, and should not be construed as a commitment by Hysitron, Inc.
Hysitron, Inc. assumes no responsibility or liability for any errors or inaccuracies that
may appear in this document or any software that may be provided in association with
this document.

Except as permitted by such license, no part of this document may be reproduced,
stored in a retrieval system, or transmitted in any form or by any means without the
express written consent of Hysitron, Inc.

Information in this document is provided in connection with Hysitron products. No
license, express or implied, by estoppel or otherwise, to any intellectual property rights
is granted by this document.

EXCEPT AS PROVIDED IN HYSITRON'S TERMS AND CONDITIONS OF SALE
FOR SUCH PRODUCTS, HYSITRON ASSUMES NO LIABILITY WHATSOEVER,
AND HYSITRON DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING
TO SALE AND/OR USE OF HYSITRON PRODUCTS INCLUDING LIABILITY OR
WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE,
MERCHANTABILITY, OR INFRINGEMENT OF ANY PATENT, COPYRIGHT OR
OTHER INTELLECTUAL PROPERTY RIGHT.

Copyright © Hysitron Incorporated 2011.

3D OmniProbe, Click Mode, Hysitron, nanoECR, nanoDMA, nanoDMA Transducer,
nanomech, nanoTensile, NorthStar tip, performech, picolndenter, Seeing is Believing,
ScanningWear, TriboAE, Tribolndenter, TriboLab, TriboScope, TriboView and Ubi are
trademarks or registered trademarks of Hysitron Incorporated in the United States and
other countries.

Additional electronic or paper copies are available from Hysitron upon request.
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Introduction

Hysitron Incorporated
10025 Valley View Rd.
Minneapolis, MN 55344

+1-952-835-6366

support@hysitron.com

Revision 9.2.1211

Congratulations on your purchase of a Hysitron nanomechanical testing instrument.
Hysitron testing instruments, options and user support have been designed with the
user in mind so you can be confident that you are using the most technologically

advanced, quality instrument with the highest level of user support available.

This user manual has been constructed to be accessible for any user; from the
beginner looking to embark on nanomechanical testing with a Hysitron system to the
advanced user looking for complex automation or analysis routines. This user manual
also contains the calibrations necessary for maintaining the precision and accuracy of

the instrument as well as instructions for performing testing and analysis.

In order to bring attention to important items that may cause damage to the equipment
or information that may ease a process, this user manual contains two icons that will
be displayed in the margin near the relevant information.

& Warning

® Information
Special attention should be given to any warning information discussed in the user

manual as damage to the instrument can result from improper use.

TriboScan 9 and higher is organized into tabs. Tabs, sub tabs, side tabs and buttons
are labeled in ITALICS. Because of the overall tab/sub tab structure of the TriboScan
software there are fewer menu options, nonetheless, menu items, directories and

filenames are labeled in BOLD.

Following each step in a procedure is important to minimize the possibility of
equipment damage and to obtain quality data. For this reason, all procedures are

numbered to distinguish procedures from general user manual information.

If a problem or question should arise which is not addressed in this user manual,
please contact the Hysitron service department (listed at left) or your local service

representative before proceeding.
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The hardware components that comprise Hysitron nanomechanical testing systems
are fragile and should be handled with extreme care. As a direct result of the
sensitivity associated with nanoresolution testing it is necessary to ensure that the
hardware components are properly calibrated, which will be discussed in the setup

and calibration chapter of this user manual.

Although this user manual will emphasize the importance of properly installing and
calibrating the hardware it is equally important that the equipment be properly
handled and stored when not in use. The specially designed case and stand for the
Picolndenter should be used for storage when it is not in use. Other components that
were not supplied with a case are generally less sensitive and should be stored in a
low-humidity location where the components will not be subjected to any physical

shock or excessive vibration.

Extreme care should be taken when installing, removing or storing the components associated with
the nanomehcanical testing instrument. If the user is unsure of how to install, remove or store a
component, contact a Hysitron service engineer prior to proceeding.

Hysitron instruments are sensitive to humidity and excessive vibration or shock. For a document
outlining the required environmental conditions for optimum performance, contact a Hysitron
service engineer.

The basic hardware components of the PI 95 system are listed below. Each of the

components listed below will be discussed within the contents of this chapter.

* PI 95 Picolndenter transducer assembly

* PI 95 Picolndenter performech control unit
* Sample mounting bracket

e Computer and data acquisition system
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Section 1.1
System
Requirements
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System Requirements

The PI 85/P1 95 SEM/TEM Picolndenter is supplied with:

* Holder/base with capacitive transducer sensor
* performech control unit

» Data acquisition notebook computer

* Cabling

* Video overlay hardware

* TriboScan 9.2 software (or higher)

A desk or cart at least 1 m (40”) X 1 m (40”) should be used for the computer station
and auxiliary electronics. Additional samples, sample holders, probes, or accessories

will depend on the individual system.

The system is designed for a specific voltage. Depending on the geographical location
of the instrument, the system will run either on 110/120 VAC (60 Hz) or 220/
230 VAC (50/60 Hz). The maximum current required at any time will not exceed
15 A for the 110/120 VAC system and 8 A for the 220/230 VAC system.

Never attempt to connect the system to a voltage supply other than what the instrument has been
designed to be use.
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Section 1.2
Transducer
Assembly

Figure 1.1
JEOL TEM Picolndenter

Displacement
Measurement
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Transducer Assembly

The core of every Hysitron PI 95 Picolndenter system is the capacitive force/
displacement transducer developed by Hysitron (Figure 1.1). The traditional three-
plate capacitive design provides high sensitivity, a large dynamic range and a linear
force or displacement output signal with displacements up to 5 um and loads up to

1.5 mN.

The PI 95 Picolndenter is a 1D (normal force only) transducer that consists of the
force/displacement sensor, drive circuit board and hardware used to mount the

transducer to the TEM system.

The transducer sensor consists of fixed outer electrodes (drive plates), which are
driven by AC signals 180 degrees out of phase with adjacent drive plates. Since the
drive plates are parallel to each other and closely spaced with respect to the lateral
dimensions, the electric field potential between the plates varies linearly. Since the
signals applied to the drive plates are equal in magnitude but opposite in polarity at
any instant, the electric field potential is maximized (equal to the applied signal) at
the drive plates and minimized (zero, the two opposite polarity signals cancel each

other out) at the site centered directly between the drive plates (Figure 1.2).
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Figure 1.2

Transducer actuation diagram

Force Measurement

Table 1.A

Specifications of the Transducer

Revision 9.2.1211

Assembly

Transducer Assembly

Quasistatic Transducer at Rest
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The input impedance of the system is significantly larger than the output impedance

of the transducer, so the center electrode will assume the same potential present at its

position between the drive plates. The result is a bipolar output signal equal in

magnitude to the drive plate at maximum deflection, zero at the center position and

varying in a linear manner between maximum displacement and the center position.

The force is applied to the transducer electrostatically. To apply a force, a large DC

bias (up to 600 V) is applied to the bottom plate of the capacitor. This will create an

electrostatic attraction between the center plate and the bottom plate, which will pull

the center plate down. The force can be calculated from the magnitude of the voltage

applied. The maximum normal force available from the PI 95 Picolndenter system is

about 1.5 mN, however, the maximum available load will vary for each system.

PI195 (JEOL)
Maximum Force 1.5 mN
Load Resolution <3nN
Load Noise Floor 200 nN
Maximum Displacement 5 pm
Displacement Resolution <0.02 nm
Displacement Noise Floor 0.4 nm

11 of 82



Ol
IS - YSITRON

Section 1.3
performech
Control Unit

Figure 1.3
performech DSP control unit
back panel

Section 1.3.1
Safety
Considerations
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performech Control Unit

Hysitron TI 950 Tribolndenter, TI 750 Ubi, TS 75 TriboScope and PI 95/PI 85
Picolndenter systems utilize the newest generation of DSP based control units

available from Hysitron - the performech control unit (Figure 1.3).
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6 o (o N N L v I
O €] @)
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~ |=e
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(& %D @ / A A ‘
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FUNCTIONAL RISK OF ELECTRIC SHOCK|
GROUND TERMINAL | DO NOT OPEN
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Connect an appropriate AC power cord to the AC input connection on the back of the
performech control unit and then into an available grounded (earth grounded) power
outlet. The performech control unit accepts line voltages from 100 to 240 VAC, 50/
60 Hz, 2.5 Amp maximum, single phase. Do not position the equipment so that it is
difficult to disconnect the AC power cord. If mounting in a rack and plugging into a
rack power source be sure the main rack power cord or power switch remains

accessible for disconnection.

The performech control unit uses two 250 V, 2.5 Amp, Type “T” (time lag) fuses
located in the main power inlet. To inspect or replace the fuses, disconnect the power

cord from the back of the control unit and pull out the fuse tray.

If the equipment is operated in a manner not specified by this user manual, the protection provided
by the equipment may be impaired.
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Ventilation
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performech Control Unit

The performech control unit requires adequate ventilation to operate normally. There
are two cooling fans located on the rear of the performech control unit and one small

cooling fan for each DSP or DAQ board located within the performech control unit.

Excess heat is expelled out of the vents located on the top of the performech control
unit. Because of this, it is important that no equipment is placed on top of the
performech control unit that obstructs these vents. It is also important that if the
performech control unit is rack-mounted adequate space is given between the top of

the control unit and other electronics.

If the vents of the performech control unit are obstructed, as the heat builds up, the
user may start to notice peculiar operation of the software as the various power
supplies begin to operate out of the normal range. Eventually, the 5 VDC power
supply may fail, which powers all DSP and DAQ boards so instrument operation will
terminate. If this occurs, clear the obstructed vents, allow adequate time for the

control unit to cool then attempt to restart the system.

Do not obstruct the vents on the top of the performech control unit or the ventilation fans on the rear
of the control unit. Obstructing these vents may cause the unit to over heat can cause damage to the
internal components.
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Section 1.3.3
Back Panel
Overview
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performech Control Unit

The performech control unit is designed to combine many external components into
one easy-to-operate, computer driven control unit. The performech control unit is
equipped with a number of input/output BNC connections that are used for additional
options/upgrades. Options and upgrades that utilize these auxiliary connections will

be addressed in the respective user manuals.

The performech control unit includes two transducer connections (each with a 15-pin
and a 25-pin connection). Standard systems should have the transducer connected to
Transducer 1 with the 15-pin connection (the 25-pin connection is used only for
MRNP/3D OmniProbe systems). There is one orange LED near each of the
transducer connections. When the orange LED is illuminated high-voltage is being

supplied to the transducer.

Systems that include TriboScan-based in-situ imaging (TI 950 TriboIndenter and
TI 750 Ubi systems), or which use a TriboScan-controlled piezo for positioning (such
as the PI 95 TEM Picolndenter system) will connect the instrument piezo scanner to

the Piezo connector.

The Emergency Stop BNC should be connected to the stage controller for TI 950
TriboIndenter and TI 750 Ubi systems and left unconnected for TS 75 TriboScope
and PI 95/PI 85 Picolndenter systems (as there are no Hysitron-supplied automated

stages).

There are five green LED lights on the rear of the performech control unit. The five
lights represent different voltages being supplied by the internal power supply. All

five green lights should be illuminated when the performech controller is operational.

There are three red LED lights on the rear of the performech control unit. The top red
light is illuminated if no USB connection is detected between the control unit and the
computer. The bottom red light is an emergency stop indicator. If the system is being
used with an ESP 6000 stage control unit, a lit LED represents normal operation and
an unlit LED represents emergency stop. If the system is being used with an ESP 300/
301 stage control unit, a lit LED represents an emergency stop and an unlit LED
represents normal operation. If the system is a TriboScope, the status of this light is

unimportant.

14 of 82



Ol
IS - YSITRON

Section 1.34
Specifications

Table 1.B
performech specifications
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performech Control Unit

The specifications for the performech control unit are given in Table 1.B

Electrical Requirements

(all configurations)

Voltage 100-240 VAC
Frequency 50/60 Hz
Current 2.5 Amp (max)

Fuses
(two located at appliance inlet)

2.5 A, 250 V, Type “T”, 5x20 mm

Environmental Conditions

(for safe operation of the performech control unit)

Temperature

5°C-40°C

Maximum Relative Humidity

80% at 31°C, 50% at 40°C

Altitude

Up to 2000 m

7]

ymbols Related to Safety

Warning: Disconnect power input before removing the
cover. Only qualified personnel should make adjustments
to the instrument.

Caution: High voltage connection.

Ground: Indicates the terminal is connected to protective
earth ground and chassis ground.
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Section 1.4  The Hysitron PI 95 PicoIndenter has been designed to be used with the performech
Instrument  control unit (Figure 1.4). There are two connection between the PI 95 Picolndenter
Connections  and the performech control unit (both being 25-pin cables). Connect the cable labeled

Transducer to the Low Load connection under the Transducer 1 heading and the

Piezo cable to the Piezo connector.

The DSP performech controller connects to the data acquisition computer via a single

USB cable.

Figure 1.4

Tl 95 Picolndenter series To TEM PicoIndenter s

connection diagram Auxillary High
DIN1 | ADC 1 ARC2 ADC3  ADC 4 Power Piezo Load
o ) o .
an &
DIN 2 -
,
DouT °
.
Transducer 1
) ( Transducer 2
Ay SN A, @ use
To Computer USB
To TEM PicoIndenter
‘\7\6 The transducer and piezo components use similar cable connectors. In order to prevent damage to
the TEM Picolndenter or control unit always verify that the transducer and piezo are connected to

their respective locations on the control unit.

@ Hysitron recommends having the performech controller powered on with the TriboScan software
running for 20 minutes prior to testing with the PI 95 Picolndenter.

@ Cables should not be connected the PI 95 Picolndenter holder until the head has been installed into
the microscope. It is not necessary to power off the performech control unit when connecting or

disconnecting cables.
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Section 1.5
Data
Acquisition
Computer

®

Computer Features

Table 1.C

Computer cards and
requirements for Hysitron
instruments
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Data Acquisition Computer

Hysitron instruments have been designed to be software controlled with the data
acquisition computer supplied with the instrument. A new Hysitron system data
acquisition computer, as of the time this manual was written, will meet or exceed the

following specifications.

«  Microsoft " Windows® XP Professional SP2

«  Microsoft " Office 2010

e Intel® Core 2 Duo E7400 2.8 GHz
e 250 GB hard drive

* 3 GB DDR2 RAM or higher

¢ CD-R/RW drive

¢ Onboard LAN

* 197 LCD flat panel monitor

PI 95/P1 85 systems will be supplied with a well-equipped notebook computer with identical or better
specifications as compared to the desktop computer described in this section.

A list of standard computer cards and features for the various Hysitron systems as

well as cards required for additional options is listed below

TI 950 TI 750 TS 75 PI 95/PI 85
TriboIndenter Ubi TriboScope Picolndenter
IEEE-1394 Port Required Optional
Dual Core Processor Required
USB 2.0 Required
Video Display Graphics Required Not available
Card

1280 x 1024 Screen

Resolution Highly Recommended

Microsoft Windows

Professional XP Required

Acoustic Emissions Not available

Measurement PCI Card

Optional

Additional PCI cards may be required for systems running legacy stage control units, optical camera
systems, or GPIB devices (lock-in amplifier, nanoECR SourceMeter, etc...).

Any computer cards, operating system requirements or hardware that is required for
for the system will be professionally installed and tested for compatibility at Hysitron
and should only be serviced by qualified Hysitron personnel. Future options and

upgrades may require additional computer cards.
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The Hysitron PI 95/P1 85 Picolndenter is supplied with the TriboScan software suite.
TriboScan has been designed to incorporate all basic instrument operation and

analysis as well as the operation of any instrument options and upgraded features.

Although TriboScan has been designed to be fully-automated and incorporate the data
collection and analysis for many of the available instrument upgrades and options
there may be additional stand-alone software packages for some options.
Additionally, there may be communication port settings as well as other system
settings that must be entered or verified before the instrument or feature will operate

normally.

This chapter will discuss the sample installation, probe and transducer installation as
well as the system calibrations to keep the instrument performing at its maximum

efficiency.

TriboScan, and any associated Hysitron software, is installed in the C:->
Program Files > Hysitron directory. Important files such as saved load functions

and calibration files can all be found within this directory.

Installing software or licensing the instrument for components that are not installed on the system is
not recommended and may cause the instrument to become unstable. If the user is unsure of what
software should be installed on the instrument contact Hysitron before proceeding.

Do not alter any files located within the Hysitron folder unless directed by the user manual or
Hysitron service engineer. Modifications of any files within this directory may cause the software to
become unstable.
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Section 2.1
Picolndenter
Axes

Table 2.A
Picolndenter coordinate system
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Picolndenter Axes

When combining the Hysitron PI 95 Picolndenter and the existing TEM system the
axis labeling system becomes convoluted. For users with previous indentation
experience the labeling system should be intuitive, however, users who experience is
primarily with TEM systems may find the Picolndenter axis system more difficult to
comprehend. Special care should be taken to understand the difference in axis

orientation so as the instrument can be properly operated without causing damage.

TEM Picolndenter
X Z
Y X
Z Y

There is a large knob on the end of the Picolndenter that controls the motion in the Z-
axis direction; clockwise retracts the probe and counterclockwise approaches the

sample.

The two smaller knobs on the bottom and left of the Picolndenter controls the motion

in the Y and X-axis, respectively.

The feedback loop within the software should be disabled prior to using any manual control knobs
on the PicoIndenter.

The large knob on the end of the Picolndenter controls the Z-Axis direction.
Clockwise — retracts probe from sample
Counterclockwise — probe approaches sample.
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Section 2.2
Probe Mounting

Figure 2.1
Location of front-end
attachment screws
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Probe Mounting

Mounting the probe to the transducer is a very delicate process; care should be taken
not to over tighten the probe or apply any lateral forces when mounting the probe.

The procedure for mounting the probe is outlined below.

1. Turn off TriboScan and disconnect the PI 95 Picolndenter cables from the
performech controller.

2. Remove the holder from the TEM system and place the holder on the acrylic
resting mount.

3. Wearing rubber gloves and with a small flat-ended screw driver remove the
two screws holding the front-end onto the transducer (Figure 2.1).

Extra care should be exercised to prevent contacting the front-end of the transducer with any foreign
objects.

Do not modify or adjust any of the O-rings on the TEM Picolndenter or touch the area between the
front O-ring and the probe with ungloved hands as this can compromise the vacuum of the TEM
system.

4. Carefully remove the probe from its protective sheath holding the probe in
the left hand if the user is right-handed (Figure 2.2).
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5. The probe inserts into the probe tool, point first. The probe tool should be
held upright at all times. The probe is only held in the tool by gravity and
friction, so extra care should be exercised to prevent the probe from falling
out of the tool.

Figure 2.2
Removing the nanoindentation
protective sheath

Figure 2.3
Probe mounting tool and probe

Side View End View
geometry

@ .0.‘0‘1))))1)))))- .

‘\}\é Use caution when inserting the probe into the probe tool as any contact between the tip of the probe
and the installation tool could chip or break the point.

Probe Mounting Tool

6. Place the threaded end of the probe onto the threads of the TEM
Picolndenter at a slight incline angle and then tilt the tool horizontally to
prevent the probe from falling out of the tool.

7. Gently turn the probe counterclockwise until a slight click is felt when the
lag of the threads falls into place. This is to avoid cross-threading of the
threads of the screw.

‘\}\é Be careful not to cross-thread the probe on the transducer screw. The probe should turn easily. If
the probe turns tightly, or becomes stuck, contact Hysitron customer service for advice to avoid
damage to the probe or transducer.

8. Gently turn the probe clockwise until the spring of the probe tool begins to
deflect.
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9. Pull the probe tool straight away from the transducer taking extra care not to
contact the tip of the probe with the tool.

10. Reinstall the front-end of the PI 95 Picolndenter with the two small flat-end
screws (Figure 2.1)

11. Follow steps 1 through 10 in reverse order to remove the probe from the
transducer.

It is important that the indentation probe is installed fully onto the TEM Picolndenter.
When installed, the probe should be flush against the transducer screw as shown in

Figure 2.4b. A probe that was not fully installed is shown in Figure 2.4a.

After the nanoindentation probe has been mounted, the holder can be installed into

the TEM (as outlined in the following sections).

‘\7\5 Always perform the probe mounting procedure with the holder laying on its side within the supplied,
acrylic resting platform.

‘\7\6 Never allow the nanoindentation probe tool to hang freely from the transducer. The user should
always be supporting the mass of the tool or damage to the finely calibrated springs within the
transducer may result.
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Figure 2.4
Improperly (a) and properly [b)
installed probe
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Section 2.3  Justas any sample would be prepared for a TEM, the thickness of the area of interest
Sample should be less than approximately 300 nm depending on the chemistry of the sample
Mounting and the accelerating voltage of the TEM. The height of the sample is limited by the
travel range of the Picolndenter axes and if a Hysitron-supplied sample wedge is

being used the sample surface should be centered in the field of view. The Hysitron-

supplied sample wedges are approximately 0.5 mm thick. Use of thicker sample

substrates may cause the sample to be too tall and block the electron beam which

would result in no image of the sample surface.

Sample Mounting  The Hysitron-supplied sample mount consists of a bracket and screw (Figure 3.1).

Procedure The procedure for mounting samples is given in the procedure below.
Figure 3.1
Picolndenter sample mounting
bracket Sample

Epoxy

Grooves for ) C
Tweezers

Locking Screw

1. Adhere the sample to the bracket. Hysitron recommends using a thin layer of

a semi-permanent, adhesive such as CrystalbondTM. When adhering the
sample to the bracket efforts should be made to center the sample as the X/
Y-axis range of the Picolndenter is limited. The sample should be mounted
as level as possible to ensure that the loading axis is normal to the sample
surface.

2. Fully retract the indentation probe by turning the knob on the end of the
Picolndenter clockwise.

3. Wearing rubber gloves and using tweezers to hold the sample mounting

bracket to the front end, tighten the screw that holds the bracket to the
front-end (Figure 3.2).
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Figure 3.2

Picolndenter with sample
assembly installed
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Bracket locking screw Sample Transducer

Sample mounting bracket Diamond probe

4. Turn the knob on the end of the Picolndenter anti-clockwise to move the
probe until it is visibly near the sample.

‘\7'@ To prevent damage to the TEM system and/or the Picolndenter the sample must fit fully within the
sample bracket edges.
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Installing the Picolndenter

The following is the procedure for inserting the PI 95 Picolndenter into the TEM. It is
assumed the sample has been adhered to the sample mounting bracket and the

mounted to the Picolndenter front-end.

1.  Power off the performech control unit.
2. Examine the O-rings to ensure that they are free of any lint or particles.

3. In order to simplify the sample approach, before installing the Picolndenter,
use the manual Z-axis knob on the end of the Picolndenter to bring the
probe near the sample. Try to position the probe approximately 100 um
from the sample surface (for comparison, the width of the probe is approx-
imately 200 pum).

Do not contact the probe with the sample during this manual approach as serious damage may
result.

4. Load the Picolndenter into the TEM as any standard TEM holder would be
inserted.

5. Connect the piezo and transducer cables to the Picolndenter.

6. Connect the transducer cable to the Transducer 1 connection on the rear of
the performech control unit.

7. Connect the piezo cable to the Piezo connection on the rear of the perfor-
mech control unit.

8. Power on the performech control unit (and computer if it is not powered on).

9. Start TriboScan by selecting the TriboScan icon on the desktop or by select-
ing TriboScan from the Windows start menu.

The cables should be connected between the PicoIndenter and the performech control unit so that no
unnecessary strain is applied to the electronics or cables.

Cables should be routed away from sources that may induce additional noise such as computer
monitors or other electronic devices.
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Transducer Calibrations

System Parameters
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With the mechanical portions of the instrument set up the system can be powered on.
The order to power on the instrument is unimportant, however, all electronics should

be powered on prior to starting TriboScan.

The electronics must be powered on before starting the TriboScan software. If the electronics are not
powered on before starting TriboScan, the system will not properly initialize the attached hardware
components.

When a new transducer is first used, a transducer constants file should be created. A
new transducer constants file can be created from the Calibration tab - System
Calibration sub tab. To create a new file, select File > Save as and create a new file
name. All transducer calibration files display the normal and lateral force calibration
data. If the transducer being used is a 1D (normal force only) the X-axis constants are

unused and may be ignored.

If a transducer constants file has already been created for the transducer, it can simply
be loaded from the Calibration tab = System Calibration sub tab, select File >

Open.

After a transducer constants file has been loaded or created, the proper constants can
be copied from the transducer constants sheet provided with the transducer and then

fine-tuned with the respective calibration(s).

There are three main areas of the System Calibration tab:

Constants in this area are copied directly from the transducer constants sheet or
are properties of the transducer/instrument that WILL NOT be adjusted during
the calibrations.

Constants in this area are copied directly from the transducer constants sheet or
are properties of the transducer/instrument that WILL be adjusted during the

calibrations.

Variables in this area are intended to match corresponding hardware settings.
This area contains gain and attenuations settings for the system.
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Transducer
Constants Sheet

A unique transducer constants sheet is produced each time a transducer is calibrated
at the Hysitron factory. An example transducer constants sheet for a lateral force

transducer is given in Figure 3.3.

Figure 3.3
Example transducer constants
sheet

Tare

Load Scale Factor
Displacement Scale
Factor

Electrostatic Force
Constant

Self Calibration Check

Revision 9.2.1211
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3/4/2003

Transducer Calibration Constants

Transducer ID: SN5-138-61

Z Acxis

Tare (without the tip) -329{mg
Load Scale Factor (Force) 1|mV/mg
Displacement Scale Factor (Deflection) 18.350|mV/um
Electrostatic Force Constant 0.03425 pN/Vz
Self Calibration Check 484|mg
Maximum Force 12.330|mN

Every transducer constants sheet will have the following normal axis parameters

located under the Z Axis heading of the transducer constants sheet:

The Tare parameter is a value that indicates the rest position of the
micromachined comb drive plate. Verifying the tare value is an important step in
starting the instrument and is discussed in the next section of this chapter.

The Load Scale Factor is calibrated at Hysitron and should be entered into the
transducer calibration file in TriboScan.

The Displacement Scale Factor is calibrated at Hysitron and should be entered
into the transducer calibration file in TriboScan.

The Electrostatic Force Constant is calibrated during the Z-Axis Calibration.
However, TriboScan will require an approximate starting value in order to
calibrate the transducer properly. This value should be entered into the transducer
calibration file and will be updated by the software following the Z-Axis
Calibration.

The Self Calibration Check is a troubleshooting tool to verify that the springs that
suspend the center plate of the transducer have not been damaged since the
transducer has been calibrated. The Self Calibration Check is performed by
viewing the tare value of the transducer then pausing TriboScan, turning the
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Maximum Force

Section 2.5.2
Checking the
Tare Value

Figure 3.4
Location of Update button and
verification of tare value
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transducer upside-down, un-pausing TriboScan and viewing the tare value. The
Self Calibration Check value should be the difference between these two
measured tare values. It is unnecessary to perform the Self Calibration Check
unless instructed by a Hysitron service engineer.

The Maximum Force is calculated based on the electrostatic force constant and
transducer plate spacing. TriboScan will automatically generate a maximum
force following the Z-Axis Calibration.

The tare value of the system can be read at any time the nanoindentation probe is not
in contact with a sample surface. Verifying the tare value is approximately the value
given on the supplied transducer constants sheet (typically located within the black
transducer case) after the components are installed and the software is started
indicates that the transducer and probe are installed correctly and the connections are

secure.

To read the tare value of the system, click the Calibration tab > System Calibration
sub tab and click the Update button under the System Parameters heading

(Figure 3.4). The tare value will be displayed in the parameter box to the right of the

Update button.

Tr System Parameters
Indentation Axis Mictoscope Feedback Gain (Displacement) 5] 1

e (ms]
T 7]

pdate| /

nanoDMA Settings

ADC

=

Load

Transducer Calibrations

Indentation Axis

Calibration Results
3 om0
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DSP Calibration Result window
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The tare value of the system should be verified each time the performech control unit is powered on
or any hardware components have been removed, replaced or modified.

A tare value reading that varies from the transducer constants sheet by more than approximately
+ 50 mg from the recorded value indicates that there may be a problem with the transducer or probe
installation.

The performech DSP-based controller requires an ADC Calibration in order to
calibrate the data acquisition boards and the associated gains within the performech
control unit. The ADC Calibration is only required to be performed once for each
system configuration (typically performed during the initial installation) but can be

performed as frequent as desired to confirm that the gain settings are accurate.

The ADC Calibration is accessed from the Calibration tab - System Calibration sub
tab > ADC Cal button. After selecting the ADC Cal button the system will
automatically perform the ADC Calibration and generate the DSP Calibration

Results window (Figure 3.5).

]
Transducer 10 board Auiliaty 10 board
Measued Gain  Measued Offsst  Gain Value Offset Value MessuedGain  MesswedOffset  GainValue Offset Value
apco | 1.000005E+0 | | |-3.435884E5 4723157E-9 54232724 apcg | -9.993397E 1 |:5.296780E6 4727821E-3 -1.004083E-3
lapct | -9.93365E-1 143833435 47323ES  |3489511E3 apce |-99assce | | 1886297 5 472761369 |-1187991E2
|apcz | -1.000001E+0 | | 290607265 4722145E9  |7.986574E-3 spcio) 999993E1 | |22357e%E 5 | (47ammES (730725063
apca | -a9s99asE | | 1.434737E 5 4.733204E-9 5.089046E-3 aocit) -a9as97iE1 | | -6.054956E 6 4723441E-9 -5.724449E-3
|apca | 100000340 | | -2307851E5 472087E8  |1.378268E-2 apc12| 993351 | |/ 65521396 4727977ES |924%63% 3
|apcs | -1.000001E+0 | | -4.20130465 473281969 |6.167620E-3 spc13) 99388 | |l 1a71514E 5 4729538E9  |-BAOS0B1E-3
apce | 1.000001E+0 | | 119198765 4.729536E-9 1.044573E-2 apci4) -99asss1 | |-2634729€ 5 4.727843E-9 8.004381E-4
|apcz | 1.000000E+0 | | 1.877771E 5 47316239 90092284 socis| 99asee 1 | | 6305264 6 4TIETES 12904542
Measued Gain_ Measued Offset  GainValue Dffset Value MeasuedGain_ MeasuedOffset GainValue OffsetValue
paco | 1000125840 | | [1.804737€ -4 2161744E+48  |2136685E+9 paco |[gsssesse | |20511124 2160911E+8 2137535649
DACT Y [ ga9paa7e-1 | | 141194694 2.158908E+8 2136889E+9 DACT |/.ggogse4E1 | | 566367564 2158289E 48 2137825649
DAC2 | [1.0001708+0 | | -7.022827E-4 2162391E+8 2137848E+3 DAC2 ||1.000038E+0 | | -6.178957E-4 2.166288E+8 2137906E+3
DAC3 | |.1.000089E+0 | | |-8.874994E-4 2157910E+8 2137981E+3 DAC3 |\-1.000011E+0 | | -6.683912E 4 2160129E+8 2137834E+9
I Approximate Values = -1 I rer
oK
I Approximate Values = 0 I

Within the DSP Calibration Results window there will be one tab for each of the

installed data acquisition cards within th performech control unit (the number of data
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acquisition cards depends on the instrument options and upgrades). The Measured

Gain values on all tabs should be -1 £ 0.004. The Measured Offset values should be

near zero (less than 10'3). The Gain Value and Offset Value are not used for the ADC
Calibration and the listed values are unimportant. If any of the values within the DSP
Calibration Result are not within the given range contact Hysitron for further

instruction.

Do not perform the ADC Calibration while the probe is on the sample surface.
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Section2.54 The Electrostatic Force Constant for the Hysitron micromachined comb drive
Z-Axis Calibration  transducer is determined by the area of the drive plates, the area of the center
electrodes and the distances between the two squared. Because the center plate of the

transducer is floating on springs, the spacing between the plates can change and thus

change the Electrostatic Force Constant.

During an indentation test, the center plate (to which the probe is attached) of the
transducer is driven into the sample surface. This movement of the center plate will
cause a fluctuation in the Electrostatic Force Constant and if the transducer has not

been properly calibrated a significant amount of error may be present in the results.

TriboScan automatically accounts for changes in the Electrostatic Force Constant at
large displacements. However, in order to make this correction, TriboScan must know
the Plate Spacing of the transducer. The Plate Spacing and Electrostatic Force

Constant is given by performing the Z-Axis Calibration.

It is important that the Z-Axis Calibration be performed every day or each time the
instrument is used, whichever comes first. The Electrostatic Force Constant is likely
to vary slightly from day to day based on factors such as a change in temperature or
humidity. Additionally, the Z-Axis Calibration is a good indication that the system is

working properly and the components are connected securely.

Performingthe  The calibration is performed with the nanoindentation probe installed in the
Calibration transducer and the transducer installed in the instrument. The Z-Axis Calibration will
be performed in the air, far from any sample so it is important that there is adequate

space between the nanoindentation probe and any samples or the sample stage.

The transducer is carefully calibrated at Hysitron prior to shipment and will be
supplied with a constants sheet. The constants given on the supplied transducer
constants sheet must be entered into the System Calibration tab. A brief definition of

the constants within the TriboScan software is listed below:

Load Scale Factor An inherent property of the transducer, the Load Scale Factor is calibrated at
Hysitron prior to shipment. The Load Scale Factor will not change during this
calibration.
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Z-Axis Calibration

The Displacement Scale Factor is a measurement of the output voltage of the
transducer as a function of the displacement of the center plate. The
Displacement Scale Factor will not change during this calibration.

The Sensor Bias is a set parameter based on the voltage output from the
transducer controller. This value should only be changed at the direction of a
Hysitron service engineer and will not change during this calibration. The default
is On (-0.0327).

The Machine Compliance is a calculated value for a particular instrument/
transducer/probe combination. This value is typically about 0.0 for a TEM
Picolndenter system. The Machine Compliance will not change during this
calibration.

Typically used in cases of adhesion testing or samples that require a large lift-off
height. The Bias Offset defines the amount of negative displacement available
with the transducer. This parameter can be increased, however, increasing the
negative displacement will lower the available forward displacement. The Bias
Offset will not change during this calibration. The default is 100 nm.

The Electrostatic Force Constant is found on the transducer constants sheet and

will be a value around 0.03 uN/V?2. The Electrostatic Force Constant must be set
to a reasonable value prior to starting the Z-Axis Calibration or the calibration
may not produce valid results. The Electrostatic Force Constant will change
during this calibration and may vary from day to day based on environmental
conditions.

Upon entering or changing any values in the System Calibration tab, the file will be
saved to the currently open transducer constants file (the file path is given at the top of
the System Calibration tab). Different calibration files can be accessed by clicking the

Open icon and a new file can be created by clicking the Save A4s icon.
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Figure 3.6
Verification of Z-axis transducer - [olx]
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With the transducer constants correctly entered, click the Calibrate button located
under the Indentation Axis heading given in Figure 3.6 to begin the Z-Axis

Calibration process.

Upon selecting the Calibrate button, the system will automatically open the Load

Function tab > Indent sub tab (Figure 3.7).
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Figure 3.7
Z-Axis Calibration load function

Figure 3.8
Z-Axis Calibration reminder
window
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Z-Axis Calibration
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When the system is in the Z-Axis Calibration mode, the user can double right-click on the Cal Air
Indent button to return to normal system operation.

Verify that the current load function is the Indentation Axis Calibration.ldf with a
Peak Force of 600 uN. The maximum required force will vary for different
transducers; the given force should achieve a displacement of approximately 3-4 um.
Click the Cal Air Indent button and the Z-Axis Calibration reminder window

(Figure 3.8) will open. Click Start to continue with the calibration.

Single Indent x|
Reminder: Is the load function set up conectly?

Start 1 Cancsl |

Upon clicking Start in Figure 3.8, an indentation test will be performed in the air and

the real-time plot will be displayed similar to Figure 3.9
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Realtime plot of load vs.
displacement, displacement vs.

time and load vs. time for the Z-
Axis Calibration

Figure 3.10

Z-Axis Calibration confirmation
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When the real-time plot has finished, Figure 3.10 will open prompting the user to
keep or discard the calibration information. If the calibration has been performed
successfully, click YES. If a setting was overlooked and the calibration was
unsuccessful, click NO, locate the source of the unsuccessful calibration and re-

perform the Z-Axis Calibration starting from the beginning of this procedure.

Air Calibration Indent x|
B o B S A e

After clicking YES in Figure 3.10 the ESF versus displacement plot (Figure 3.11) will
open to show the actual data collected during the Z-Axis Calibration (shown in red)
with respect to the fitted linear plot (shown in blue). The red plot should be very close
to the blue plot and the total displacement should be approximately 1 um. Any
significant deviation between the two plots will result in a poor calibration and may

indicate further problems within the transducer or other system components.

Displacements greater than about 1 pm may be exceeding the transducer
displacement limit and the calibration should be performed at a lower force.
Displacements less than about 0.5 pm typically have not exercised the sensor enough
to collect a reasonable amount of displacement data for the calibration. Typically,
very low displacement calibrations will appear much noisier due to the reduced

calibratable range.
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‘\7'\/: Do not attempt to approach a sample for testing without first obtaining a satisfactory Z-Axis

Calibration and ESF versus displacement plot.

The Z-Axis Calibration will finish with the result being displayed in the Analysis

tab = Indent sub tab. The result should be a scatter of data points around 0 pN and a

displacement of approximately 1 pm (Figure 3.12).

Figure 3.12

Z-axis calibration result IS T= ]
§ Mode
@ @f m 4indeniation
{nolysts | Load Function | Autamation | Calbration | Help |
Indent | Seratch | nancDMa® | Moduius Mapping | Image |
Hussi |
File Setup Analysis
L &
cw @ g sy eSS A
C:\Program Files\HyshicnhTrboScant Calibrationshindentation asis calbration.bys ) -
Hardness (GPa) [
Contact Depth m) 00
Contact Siifness (W) 00
Max Force [uN] [ili]
M Depth (nm] ]
Contact Area (nm™2) i)
Pouwer Law Cosfficients A 0.000
Power Law Coelfcients v [ aom
= Power Law Caefficients m [ oo
= Upper it EES
g Lower Fit % 20
S Urload Point 513
[
Cursor Paskion 513
Urloading Segment E 2
[terations [ o
Force () 04
” Displacement () 2280.05
- #0Optic | 0000 Force Dffset
Yoptic | 0000 Displ. Dffset
[ Gow ] Execute Fit
=l ! , | ) . \ | \ \ \ \ 1 \
0 5 180 225 300 375 450 &25 600 B75 750 B25 800 a75 Area Function
Displacerment (nm) (Graph To Clipboard = From Indent Fils
Toggle Grid From Tip Arza

The Z-Axis Calibration is now complete and the user can proceed with additional

calibrations (if necessary, depending on the instrument features) or continue with

sample testing.
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To start the TriboScan software package, double click the TriboScan icon on the
desktop or select the corresponding choice from within the Start
Menu - Programs - TriboScan. If various features are installed on the system,
the software may prompt the user regarding which mode he/she would like to run the
software in. After the initialization of the software is complete, the Analysis tab will

be the active window.

TriboScan version 8 and higher is operated by tabs within the TriboScan software.
The function of each of these tabs as well as an explanation of the available
parameters and features is given in this chapter. The tab scheme was created as an
intuitive ‘filter’ method to allow the user to easily find complex features by starting

from basic fields.

Problems starting TriboScan? Confirm that the all electronic components are powered on prior to
starting TriboScan.

Before any testing is begun, the user must be comfortable with the material presented through this
chapter of the user manual. Procedures must be followed as outlined in this manual or at the
instruction of a Hysitron representative to prevent instrument damage and obtain desirable testing
results.
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Figure 4.1
TriboScan Action Bar

Section 3.1.1
ZeroButton &
Transducer
Status

Z Displacement (nm)

Actuation (UN)

Sample [UN])

Zero Button
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The Action Bar

The Action Bar contains many of the commonly used global features of the TriboScan
software as well as displaying the system status and current testing mode. The Action
Bar contains:

* Zero button and transducer status parameters
* Back & Forward shortcut buttons

* Mode pull-down menu

* Emergency Stop button

TriboScan Quasi o
7 5 [=] B3
Displ. [hm)  Actuation(uN)  Sample (N) Mods T
2 |0.0000 |o.0000 |0.0000 @ f\}g 4 Indentstion @smr’

The performech DSP-based control unit monitors and records the transducer status at
all times. The transducer status values display the current status of the transducer at
any given time. The Zero button must be selected before approaching the sample
surface. There are three transducer status parameters and one Zero button given on the

Action Bar:

The Z Displacement status parameter displays the current displacement of the
nanoindentation probe in the Z-Axis direction. The Z-Displacement status
parameter will automatically be zeroed by the software prior to performing any
test, however, the user can zero this value at anytime by selecting the Zero
button.

The Actuation status parameter displays the current measured force being applied
to the transducer Z-Axis. This measured force includes any bias that is applied to
the transducer. The Actuation status parameter is not affected by the Zero button.

The Sample status parameter displays the current Z-Axis force being applied by
the system upon a sample for performing a nanoindentation test. The Sample
status parameter is automatically zeroed by the software prior to performing a
test, however, the user can zero this value at anytime by selecting the Zero
button.

The Zero button can be used to bring the Z Displacement and Sample parameters

to the zero position. The Zero button should be selected each time before a
sample is tested to zero the Z-Axis displacement.
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Section 3.1.2 The Back and Forward shortcut buttons operate similar to many of today’s popular
Back & Forward  internet browsers. The Back and Forward shorteut buttons are intended to allow the
Shortcut Buttons user to easily navigate common and frequently used tabs by allowing simple,

chronological navigation.

Section 3.1.3 The Mode pull-down menu determines what type of test the system is capable of
Mode Pull-Down performing at any given time. Depending upon how the instrument is licensed there
Menu will always be the option for Indentation and there may be the option for 7ensile,

nanoDMA, nanoECR, etc...

Section 3.1.4 The software emergency stop is located at the far right of the Action Bar in
Emergency Stop  TriboScan. Clicking the Emergency Stop button will halt all motion in the X/Y and Z-
Button axis (for all PI 85 systems and PI 95 systems with motorized movement). When the

software emergency stop is activated (depressed), a button labeled Enable Motors

will appear over the top of the Emergency Stop button. The motors must be enabled

by selecting the Enable Motors button before the user can continue to operate the

software.

‘\}\é For PI 85/95 Picolndenter systems the emergency stop can only be initiated by the user and there is
no system automated emergency stop.
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Indent

Figure 4.2
Analysis tab
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The Analysis Tab

The Analysis tab contains the analysis tools and functions for most data collected with
Hysitron systems. Depending on the options and upgrades that the instrument has
been equipped with, additional sub tabs may be available from the Analysis tab, each

of which would be discussed in the respective option or upgrade user manual.

The Analysis tab contains the following sub tabs:

The Indent sub tab is composed of two additional sub tabs:
e Quasi

All quasistatic indentation analysis occurs from within the Indent sub tab. This
sub tab is standard on all instruments.

¢ nanoECR

All quasistatic indentation data the contains nanoECR information is analyzed

from this sub tab. This sub tab is optional and will be available only on
instruments equipped with nanoECR.
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The Analysis Tab

The quasistatic indentation analysis (accessed from the Analysis tab = Indent sub
tab > Quasi sub tab) is used for all open-loop, load and displacement controlled
indentation analysis. Many of the shortcut icons on the menu bar at the top of the
Indent sub tab 2> Quasi sub tab are also located in the command bar and are defined

below:

Open File (also available from File > Open)

The Open File command allows the user to open any previously saved *hys
quasistatic nanoindentation file.

Edit File (also available from File - Edit File)

The Edit File command allows the user to view and/or edit any previously saved
* hys quasistatic nanoindentation file constants values. Editable values include:

* Spring Force Compensation

* Drift Rate

* Load Scale Factor

* Displacement Scale Factor

* Electrostatic Force Constant

* Machine Compliance

* Displacement Gain

* Plate Spacing

* Number of Data Points to Average

Export Text File (also available from File > Export Text File)
The Export Text File command creates a tab delimited text file of the current

* hys file so that the data can be viewed by third party programs. The text file
includes the load and displacement information with respect to time.

Print Graph (also available from File - Print Graph)

The Print Graph command prints the currently displayed plot as viewed on the
monitor.

Print Window (also available from File = Print Window)

The Print Window command prints the currently displayed window including
any fitting information and calculated values.

Plot vs. Time (also available from Analysis > Plot vs. Time)
The Plot vs. Time command displays the currently open *hys file as force and

displacement over time. This is a useful troubleshooting tool as well as useful for
certain analysis routines.
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The Analysis Tab

The Indent sub tab has additional options that do not have a corresponding icon:

The Export Multiple Text Files command allows the user to select several * hys
files to export as tab delimited text files to be used by third party programs.

The Update Multiple Files command works similar to the Edit icon but will
update several files at the same time. To use the Update Multiple Files
command:

1.  Open one of the * Ays file to be updated.

2. Go to the Calibration tab = System Calibration sub tab.

3. Enter ALL transducer constants as desired for the files to be updated.

4. Go to the Analysis tab = Indent sub tab > Quasi sub tab - File > Update
Multiple Files. When prompted select the files to be updated.

5. Open a *hys file that was updated and click the Edit icon, the Current
Parameter Values should read the desired updated values.

Using the Update Multiple Files command will modify the *.hys file(s) with all parameters listed in
the Calibration tab > System Calibration sub tab. This includes all transducer constants, Plate
Spacing, Electrostatic Force Constant and all gain settings which typically vary with environmental
changes or testing routines.

The Analysis tab > Indent sub tab = Quasi sub tab also contains six buttons and one

toggle switch:

The Force Offset button allows the user to select a new point to be the origin of
the force axis. This option is primarily intended for use with feedback-controlled
tests that have a pre-test lift height and may incorrectly register the point where
the probe contacts the sample surface as the zero force value.

The Displ. Offset (Displacement Offset) button allows the user to select a new
point to be the origin of the displacement axis. This option is primarily intended
for use with feedback-controlled tests that have a pre-test lift height and may
incorrectly register the point where the probe contacts the sample surface as the
zero displacement value.

The Graph to Clipboard button copies the currently displayed plot onto the
computer clipboard so that it may be copied into a third party program.

The Toggle Grid button cycles through the available grid options for the
displayed plot. Options include: no grid, vertical grid, horizontal grid and

horizontal/vertical grid.

The Cursor Position is given as the currently selected point on the plot as chosen
by the user.

47 of 82



Ol

i HYSITRON The Analysis Tab
Force The Force parameter displays the force for the currently selected point in the

plot.
Displacement The Displacement parameter displays the displacement for the currently selected

point in the plot.
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The Load Function Tab

The Load Function tab contains the tools necessary for creating any of the available
nanomechanical tests available with the given instrument. Depending on the options
and upgrades that the instrument has been equipped with, additional sub tabs may be
available from the Load Function tab, each of which would be discussed in the option

or upgrade respective user manual.

The Load Function tab contains the following sub tabs:

Quasistatic nanoindentation load function editor. This sub tab is standard on all
instruments.
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The quasistatic load function editor (accessed from Load Function tab = Indentation
sub tab) is used to create all standard indentation tests. The load function can be saved
at any time by clicking File > Save, likewise, a previously saved file can be opened
by clicking File > Open. TriboScan is pre-loaded with some basic load functions

located at C: > Program Files > Hysitron - TriboScan - Load Functions.
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The Load Function Tab

Save time by modifying pre-made load functions to meet your testing needs. TriboScan comes loaded
with several standard quasistatic nanoindentation load functions. Open any of these load functions
and modify the segment times, loads and number of segments instead of creating load functions from
scratch.

The Standard Load Function menu (Figure 4.4) allows easy access to some of the
most commonly used load functions including a basic quasistatic trapezoid, and noise

test.

The Standard Load Function menu is only intended as a shortcut to some of the most commonly used
load functions. Users can continue to create, edit, or modify load functions as discussed in later
sections of this user manual.
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The Automatic Save menu item allows the user to define a path and base file name
for the tests that will be performed. With the Automatic Save feature activated (with a
check, similar to Figure 4.5) when a test has been performed it will automatically be
saved to the given directory with the given base file name and a test number (i.e.,
test_000, test 001, test 002, etc...). This feature prevents the user from having to

name each individual file following a test and will speed the individual test process.
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The normal force vs. time plot will be updated after any change have been made in
the parameters below the load function plot. When a segment is selected by a single
left-click, the parameters below the plot will adjust to reflect the properties of that

particular segment.

There are several buttons on the Indentation sub tab as shown in Figure 4.3. The

buttons are described below:

Clicking the Add Segment button will add a ten-second, constant load or
displacement segment immediately to the right of the currently selected segment.
The user can select a segment by clicking on the segment in the normal force or
displacement vs. time plot.

Clicking the Remove Segment button will remove the currently selected segment.
The first and last segment can not be removed. There must always be at least two
segments and the beginning and ending force for the entire function must be
0.0 uN. The software will not allow the user to remove a segment that violates
these truths.

Clicking the Graph to Clipboard button copies the currently displayed normal
force or displacement vs. time plot to the computer clipboard so that it may be
pasted into any other available program.

The Air Indent button will perform the currently defined test a the current probe
position (no drift correction and no sample approach is performed).

Clicking the Perform Indent button will perform the defined test at the current
probe position.

(displacement control testing only) The Tune Displ. PID button opens the PID
Tuning window (Figure 4.6). The PID Tuning window is used to tune the
proportional, integral and derivative gain settings properly. The PID Tuning
window is also used to tune the Q Control gain setting.

The PID Tuning window allows the user to modify and toggle the step response
on and off. When the step response is enabled a desired blue step response will
appear in the Step Response plot and a red (measured data) plot will appear over
the plot. It is desirable for the red and blue plots to follow closely (as shown in
Figure 4.6). The PID gains can be modified in real-time while the result
continues to update on the Step Response plot. When satisfied with the gain
settings, click the Close button and the software will prompt the user if they
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The Load Function Tab

would like to save the current gain settings. The gain setting will automatically
be populated in the Load Function tab.
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Clicking the Load Func. Gen. button will launch the load function creator
software which allows the user to create complex partial unload functions. The
Load Function Generator is discussed further in the Testing chapter = Partial
Unload & Constant Strain Rate section of this user manual.

the lower center section of the Indentation sub tab there is a Control Feedback

pull-down menu that the user can select different feedback controlled options

(Figure 4.7) including open-loop, load and displacement control testing.

’,Feedback Mode IDpen Loop [ho fb) |

Control Feedback

Normal Feedback Gains

v Open Loop [ho fb)

Load Control
Displ. Control

By selecting the different types of quasistatic nanoindentation tests from the Control
Feedback pull-down menu (Open Loop, Load Control or Displacement Control) the

load function parameters will change. A description of the parameters follows:

(displacement control only) Displacement control tests are inherently more
difficult in forcing the test results to follow the desired testing load function. The
Proportional Gain looks at where the actual result is in relation to the desired
result at any given time (present error). Increasing the Proportional Gain may
result in a quicker response but increased too much may cause oscillations.
Default value is 0.00.

(load and displacement control only) This field allows the user to define the
Integral Gain. This gain has the biggest effect on how well the test follows the
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Q-Control

The Load Function Tab

load function. The Integral Gain looks at where the actual result was in relation
to the desired result (past error) and uses this information to make corrections
and bring the actual result closer to the desired result. Increasing the Integral
Gain forces the actual result to follow the desired result more closely, however,
too much Integral Gain may cause instabilities in the system and too little will
result in a sluggish response time. Default value is 1.00 for both load and
displacement control testing.

(displacement control only) Displacement control tests are inherently more
difficult in forcing the test results to follow the desired testing load function. The
Derivative Gain looks at where the actual result is going to be in relation to the
desired result at any given time (prediction of future error based on current rate
of change). The Derivative Gain works to limit the amount of overshoot;
however, increasing the Derivative Gain by too much may result in a slower
response. Default value is 0.00.

(displacement control only) Displacement control tests are inherently more
difficult in forcing the test results to follow the desired testing load function. The
Adaptive Gain is a feed-forward control that can quickly adapt to changes in the
test to regain stability. Decreasing the Adaptive Gain may result in a slower
response for complex load functions and an increased Adaptive Gain may will
force complex load functions to follow the desired result more closely. Default
value is 0.00.

Actual Result
Adaptive
—— Gain
Integral Gain = ®
Desired Result Proportional

Gain

In a high vacuum/low air damping environment, there is an increase in the
mechanical amplification at the resonance frequency and an increase in the
overall settling time of the transducer. In addition to long settling times while
operating in open-loop control mode, the closed-loop control of the test may
become quite unstable due to this effect. To solve the problems inherent in
performing nanomechanical testing in a high vacuum environment, increasing
the system damping is highly desired. The Hysitron PI95 has a Q value
(mechanical quality factor) of ~6000 in high vacuum and it is recommended to
decrease the Q value by 1000 times to achieve reasonable control.

To effectively use the Q-Control mode, the Q-Gain must be tuned in a manner
similar to tuning the PID gains for closed-loop displacement control mode. From
the PID Tuning panel, change the active axis to Z-Axis Open Loop. In open loop
mode, the transducer will begin to oscillate due to the low damping vacuum
environment. Turn on the Q-Control switch and increase Q-Gain until the
desired performance is achieved. O-Control will actively dampen the transducer
oscillation. Note that if the O-Gain is set too high the transducer may become
unstable. Once you have tuned the Q-Gain, it is recommended to do a few air
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indents to make sure there are no visible issues with transducer instability. If the
transducer appears to become unstable during the indent the O-Gain should be
decreased.

Q-Gain The O-Gain is the gain setting used when the O-Control is enabled. The Q-Gain
can be tuned by selecting the Tune Displ. PID button when the system is set in
displacement control mode.

@ For MEMs-based PI_95 systems the resonance frequency of the system is much higher and the Q-
Control and Q-Gain is typically not needed while working in vacuum.

Video Graphics The Video Graphics toggle switch enables the indentation video overlay so that
the indentation plot and SEM video can be viewed (more information can be
found in the Analysis chapter). Setting the Video Graphics toggle switch to Off
will save only a static * Ays indent plot and will have no references to the SEM
video. Setting the Video Graphics to On will save a static * hys file as well as an
* avi video file with the same file name in the same directory (if connected).

Lift Integral Gain (load control only) The Lift Integral Gain field allows the user to adjust the gain
for the system while the probe is approaching the sample surface to perform a
load control test. If the Lift Integral Gain is set too high, the system may become
unstable during the lift height, however, if the Lift Integral Gain is set too low the
probe may not lift fully from the sample surface. Default is 1.0.

Approach Rate (load control only) The Approach Rate field allows the user to set the rate for the
system to approach the sample while performing a load control test. When the
Picolndenter performs a load control test, the system approaches the sample in
displacement control mode at the defined Approach Rate and stops when the
defined Contact Force is sensed at which time the load control test is begun. The
default value of 1nm/sec is typically too slow for most tests and it is
recommended to increase this based on the distance the probe is starting from the
surface (typically 10-50 nm/sec).

Contact Force (load control only) When a load control test is performed, the system approaches
the sample in displacement control mode until the defined Contact Force is
sensed. When the Contact Force is sensed, the displacement control approach
stops and the defined load control test begins. The default Contact Force of 2 pN
will work well for a quiet system but if there is excessive instrument, stage, or
building noise the Contact Force may need to be increased.

App. Timeout (load control only) The App. Timeout parameter allows the user to define a time
to start the test if the approach time is too long. The default value of 1.0 sec is
typically much to short (as the test would typically start in the air above the
sample) so it is recommended to set the App. Timeout to a much larger value like
200 sec to ensure the probe has adequate time to contact the sample surface.

@ For more information regarding the integral, proportional, derivative and adaptive gains, refer to
the Zesting chapter of this user manual.
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The Peak Force or Peak Displacement field is used to enter the load function
maximum force (open loop or load controlled test) or displacement
(displacement controlled test) for the entire load function.

The Begin Force or Begin Displacement field is used to enter the force or
displacement for the selected segment to begin. The software will require that the
user define the same value as the ending force or displacement for the previous
segment (or zero for the first segment of the load function).

The End Force or End Displacement field is used to enter the force or
displacement for the selected segment to end. The software will require that the
user define the same value as the beginning force or displacement for the
following segment (or zero for the last segment of the load function).

The Segment Time field allows the user to define a length of time for the selected
segment. The loading rate will be automatically calculated.

The Loading Rate field allows the user to define a loading rate for the selected
segment. Segment time will automatically be calculated.

The Begin Time is the time that the selected load function segment will begin.
This field is automatically populated and cannot be edited.

The End Time is the time that the selected load function segment will end. This
field is automatically populated and cannot be edited.

The # to Average field allows the user to define how to average the collected
data. One corresponds to no averaging (raw data). Tivo corresponds to every two
data points being averaged, yielding less data but a smoother plot, and so on.

The # of Segments displays the number of segments for the open load function.
This field is automatically populated and cannot be edited.

The Data Points parameter displays the number of data points that will be
collected during the currently selected load function segment. The Data Points is
calculated based on the defined Data Acq. Rate and the time for the selected load
function segment.

The Data Acq. Rate parameter allows the user to define how many data points to
collect per second for the duration of the test. The default is 200 pts/sec.

The Total Number of Points parameter displays the number of data points that

will be collected for the entire test. This is calculated based on the Data Acq.
Rate and the total test time.
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The XYZ Manipulation tab (Figure 4.9) controls the position of the X, Y and Z-axis
piezo elements within the PI 95 Picolndenter. The XYZ Manipulation tab is used for
precisely positioning the probe of the Picolndenter with respect to the sample prior to

running a test.

The X, Y and Z-axis piezo can be manipulated by clicking the small arrows on either
side of the slider bar, by clicking and dragging the slider bar or by right and left-
clicking the large Step Size button.
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Each of the X, Y and Z axes has an identical set of controls including:

The Increment pull-down menu allows the user to select the scale of the
positioning slider bar. Selecting coarse offers the full range of the piezo element.
Selecting medium or fine offers a smaller range with greater accuracy.

The Zero button is used while operating the slider bars in medium or fine mode.
Because the entire range of the piezo is unavailable while using the medium or
fine increment, clicking the Zero button establishes the current cursor position as
the new origin thus extending the available range for the piezo elements to move
in medium or fine mode. The entire range of the piezo element is available in
coarse mode so the Zero button has no function while the axis is set in coarse
mode.

The Location indicator displays the current value of the slider bar.

The Step Size button moves the piezo the defined Step Size. The button is
intended to be used by placing the mouse on the button, then left-clicking to
move negative and right-clicking to move positive. The large, easy to locate
button is intended to help users operate the piezo positioning while focusing on
the sample or probe approaching the surface.
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Step Size parameter The Step Size parameter is the user-defined amount that left or right-clicking on
the Step Size button will move the piezo element in either the positive or negative
direction.
Perform Indent Clicking the Perform Indent button will perform the defined test at the current

probe position.

‘\7\5 Extra care should be taken to prevent the probe from contacting the sample or other surfaces while
operating the X, Y and Z-axis piezo elements.
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The Calibration Tab

The Calibration tab contains the calibrations that are required for keeping Hysitron
systems running properly. Depending on the options and upgrades that the instrument
has been equipped with, additional sub tabs may be available from the Calibration
tab, each of which would be discussed in the option or upgrade respective user

manual.

The Calibration tab contains the following sub tabs:

The System Calibrations tab is available with all Hysitron instruments and is
used to perform the calibrations necessary to verify the transducer is operating
properly and account for small changes in transducer properties that may be
caused by temperature, humidity or changing probe mass.

The in-situ tab contains the tools for calculating, saving and opening calibration
files for the piezo scanner that is used for fine positioning of the probe. The in-
situ tab also offers X/Y/Z Piezo Correction Factors to help account for offsets in
different directions when activating a specific axis.

The Frame Grabber sub tab is available with all Hysitron PI 95 Picolndenter
systems utilizing the enhanced video overlay feature. The Frame Grabber sub
tab allows the user to select the appropriate video device as well as settings and
drivers for the selected device.
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The Calibration Tab

The System Calibrations sub tab is used to perform the calibration necessary to verify
the instrument is operating properly and to account for small changes in transducer
properties that may be caused by temperature, humidity or changing probe mass. The
System Calibrations sub tab is given in Figure 4.10. A description of the parameters

given in the System Calibrations sub tab is given below.
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The Load Scale Factor is measured in mV/mg and is tuned during the initial
transducer calibration at Hysitron.

With the Load Scale Factor tuned, the resulting Displacement Scale Factor is
measured (prior to shipment) based on the position of the center plate of the
transducer with a specified applied voltage.

The Sensor Bias is a property of the transducer controller and should read On(-
0.032) at all times unless otherwise advised by a Hysitron service engineer.

The Machine Compliance is a calculated value that represents the compliance of
the entire system including the sample, probe, transducer, scanner, X/Y and Z-
Axis stage assemblies and any associated instrument base. The default Machine
Compliance for the PI 95 Picolndenter system is 0.0 and should only be changed
if instructed to do so by a Hysitron service engineer.

The Bias Offset is the amount of offset applied to the center plate of the
transducer to allow for bi-directional movement of the nanoindentation probe.
The bi-directional movement is of most importance during the /if¢ height before
performing a feedback control nanoindentation test or measuring the drift rate
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before a test is begun. The default is 180 nm, however, this value can be turned
up to 2000 nm if larger bi-directional movement is required. Keep in mind,
however, that the transducer has a maximum range of 5 um and any value entered
into the Bias Offset field will be subtracted from the total available forward range
of the Z-Axis displacement.

The Tare parameter displays the tare value of the transducer (indicator of the rest
position of the center plate of the three-plate capacitive sensor). The Tare of the
transducer, as measured at Hysitron with no probe installed, is given on the
supplied transducer constants sheet. The value given in the software will be
slightly more negative due to the mass of the probe but should be similar to the
value given on the supplied sheet. The Tare value can be updated at anytime the
system is not performing a test or in contact with a sample surface by clicking the
Update button.

The performech ADC Calibration is used to calibrate the data acquisition boards
and the associated gains within the performech controller. The ADC Calibration
is only required to be performed once for each system (typically during the initial
installation) but can be performed as frequent as desired to confirm that the gain
settings are accurate.

The Electrostatic Force is a property of the transducer that is calibrated during
the Indentation Axis Calibration. The Electrostatic Force will be approximately

0.03 ;VLN/V2 but varies by transducer model.

The Plate Spacing is the distance between the center plate of the transducer and
the lower drive plate. The default setting is 80 pm but will be calibrated during
the Indentation Axis Calibration and will vary slightly with ambient temperature/
humidity as well as probe mass.

Calibrations for the individual components of the transducer are performed by
selecting the appropriate corresponding Calibrate button under the Transducer
Calibrations heading. Transducer calibration procedures are discussed in the

Calibration chapter of this user manual.
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The in-situ sub tab

The in-situ sub tab displays the currently selected scanner calibration as well as the
tools to load a new scanner calibration. The in-situ sub tab also contains the piezo

gain settings for the X, Y and Z-axis piezo actuators.

The PI 95 Picolndenter will be supplied with a piezo calibration sheet listing an X, Y,
and Z-axis Piezo Gain as well as correction factors for the X, Y, and Z vs. each axis
piezo actuation. The user can modify the Piezo Correction Factors until the piezo

movement is acurate in the X, Y and Z-axis.

Load Function | XYZ Manipulation | Analysis | Imaging Calbration |Preferences | About |

Cument Scanner calibration file  |C:\ProgramData\Hysitron\Triboscan OFFLINE\Calibrations\Scan"default scl

S P
Max Scan Size 2.88000 m
X Piezo Gain 8.50000 nm/V
Max Scan Size 3.06000 um
X/Y/Z Piezo Comection Factors
Y Piezo Gain 850000  nmAV XMovement vs. ZInput $J0.00000  nm/V
Max Scan Size 306000 m Y Movement vs. ZInput $[0.00000  nm/V

X Movement vs. Y Input 5]0.00000 nm/V

Y Movement vs. X Input 5J0.00000 nm/V/
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Frame Grabber Sub Tab

The Frame Grabber sub tab (Figure 4.12) is used to select the video source (used for
the enhanced video overlay feature) as well as to configure the settings and driver for

the video capture device.

A description of some of the parameters given in the Frame Grabber sub tab are
given below, however, more advanced configuration will be performed during the

installation with the Hysitron service engineer.

Load Function | SEM Motor Control | Analysis Calibration | About |

System Calibtalionsl Tip Calibrati I Machine Compliance  Frame Grabber I
Frame Grabber
:
Fitter

:

[] Show Framerate Frame Rate  Video Quality (-1 = Default) Recording Delay Time (ms)

[7] Reticle = = = 0

] Aways On Top

[] Resizable Window

[] Record Test Video

Launch Frame Grabber Close Frame Grabber Stop Frame Grabber Frame Grabber Settings

The Frame Grabber pull-down menu allows the user to select the video capture
device connected to the microscope. All video capture devices connected to the
computer will be displayed so it is important that the video capture device
connected to the microscope be selected.

The Filter pull-down menu allows the user to determine the encoding method for
creating the *.avi video file.

The Refresh button updates the available parameters on the Frame Grabber and
Filter pull-down menus. The parameters will only change if a computer setting or

hardware has been modified without restarting the TriboScan software.

The Show Frame Rate check box will display the current frame rate in the lower
left corner of the video window.

The Reticle check box will display a reticle (cross-hair) on the video window.

The Always On Top check box will display the frame grabber window (usually
only used during a test) on top of the other TriboScan windows.

The frame grabber video window may need to be moved off screen to access
features within TriboScan when the Always On Top check box is selected.
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Frame Grabber Sub Tab

The Resizeable Window check box will enable the ability for the user to resize
the video window.

The Record Test Video check box will start a sample recording of the current
video window. This is usually used to verify the driver and settings.

The Frame Rate parameter allows the user to determine the number of frames per
second to display. The default setting is 20.

The Video Quality parameter allows the user to determine the quality of the
recorded video. If the video quality is set too high the software may start to
perform slowly. The default setting is -1, which is an automatic detect mode. The
user can set the Video Quality from 0 to 100 with 100 being the highest quality.

The Recording Delay Time allows the user to apply a delay in the recorded video
to compensate for any lag in the video between the test result and the video
movement.

The Launch Frame Grabber button will open the video window for the user to
view the current video feed from the microscope.

The Close Frame Grabber button will close the video window (if it is open).

The Stop Frame Grabber button will stop collecting video on the frame grabber
window but leave the video window open.

The Save Image button will save an image of the current video image.

The Frame Grabber Settings button has multiple settings to modify the video
window. The settings include things like color, tint, resolution, etc... The Frame
Grabber Settings will be configured by a service engineer for the particular
microscope during the installation and the user may need to contact Hysitron for
assistance in modifying these parameters.

The Driver Settings button has multiple settings relating to the video capture
device drivers and settings. The driver will be configured by a service engineer
for the particular microscope during the installation and the user may need to
contact Hysitron for assistance in modifying these parameters.
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About tab

The About tab contains information about the TriboScan software version number,
any associated National Instruments data acquisition version numbers, stage
controller, and software engine revision numbers. The information provided in the
About tab (especially the TriboScan version number) is often very useful to provide to

the customer service engineer when calling for assistance.

Hysitron customer support email:  support@hysitron.com

Hysitron customer support phone: +1-952-835-6366

Hysitron now offers online customer support! Go to:

http://www.hysitron.com/

to request a login username and password to access the Hysitron user support center.
The Hysitron user support center offers live online chat with support representatives,

downloadable documentation, and hundreds of knowledgebase articles to assist with

common issues and testing routines.

/2 http://www_hysitron. com/support/users/kb.php?category_id=3 - Windows Internet Explorer

@?} ~ [&] bitp: /v hypsivon, comésupponfusers/kb phpcategory_id=3 =12 [ x| [windons Lve (o]
oo e SBI v| @ http:/lwww.hysitro... X | I IO L BB © b

-

Hysitron Home =4

Knowledgebase ||| support Ticket:

(=7 General Testing & Operation (76) 7 Instrument Operation [ Testing (&7 Testing & Operation
(= Automation (7) (20) (38) Troubleshooting (19)
= Imaging (10)

(= Data Analysis (21)
(= Instrument Options & Upgrades (8) General Testing & Operation

= Error Codes (16) [ Tests. particularly automated tests, are running very slow
= Other (26) Hysitron systems utilize  considerable amount of system resources while performing tests.
el Any other program running slongside the TricoScan software such a5

Search Articles [ Testing polymer samples
With a few simple setting changes, any Hysitron system can be modified to test on nesrly any
sample. All samples are different and
@ |3} Using a fluid cell nanoindentation probe
With many testing situations, a fluid cell probe is often desired due to its extended length and

slender shaft. The extended length allows for.

Advanced Search [2) The nanoindentation probe is dirty. what should be done? -
There are many symptoms that may indicate that the nancindentation probe or sample may
be dirty. The two primary

|3) Testing on rough samples

In order to limit the effects of surface roughness, on most samples, it is recommended that.

|3 Standard hardness/modulus test

General recommendations and analysis for a standard hardness/modulus test.
|2 Nanoindentation testing on thin films
General recor

and analysis for a i test on thin films.

T [ Gmen (w00 -

K

Double left-clicking on the TriboScan in the first line of the information in the About tab will display
the current features installed and licensed on the system.
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TriboScan is a full-featured software package that combines both testing and analysis
into one easy-to-use software suite. The Testing chapter will cover common testing
methods equipped on most systems as well as basic testing example routines that
beginning users can refer to as a simple step-by-step method of performing a specific

test.

The Testing chapter assumes that all calibrations listed in the Setup & Calibrations
chapter have been satisfactorily completed. If the user is unfamiliar with the hardware
setup and calibrations required of the system either refer to the Setup & Calibrations

chapter or contact a Hysitron service engineer.

It is dangerous to perform procedures within the Testing chapter without first completing or
verifying the hardware is correctly setup and calibrated as given in the Setup & Calibration chapter.
Failure to follow the preceding procedures, as given in the Setup & Calibration chapter can result in
damaged hardware, probes or samples.

Detailed descriptions of the various TriboScan software tabs is given in the Software
chapter and will not be covered in the Testing chapter. For information on the
particular function, button or parameter that is mentioned but not discussed within the
Testing chapter refer to the appropriate tab within the Sofiware chapter for a more

thorough description.

Hysitron systems are designed for superior indentation testing. There are three
feedback modes to perform nanoindentation and nanoscratch testing. Depending upon
what the instrument was configured and licensed for, the testing modes are:

* Open-loop
* Load Control
* Displacement Control

Load and displacement controlled testing utilizes a feedback loop between the
transducer controller and transducer to precisely achieve the desired force or
displacement. Besides the ability to obtain precise forces or displacements accurately
during a test, load and displacement controlled testing is very beneficial when

measuring sample adhesion or stress-relaxation properties.
Open-loop testing is similar to load control testing, except that no feedback loop is

used. Open-loop is a useful testing mode when a load controlled test is required but

contact with the sample prior to testing is undesirable.
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Loading the Holder

With the indentation probe and sample mounted to the PI 95 Picolndenter, the holder

can be loaded into the TEM. The following procedure is recommended for loading

the PI 95 Picolndenter holder into the TEM:

Power off the performech control unit.

Check that the four screws that hold the front end of the holder (near the O-
ring) are tight.

Check the O-rings and remove any lint or particles.

Use the manual Z-axis control knob to bring the probe close to the sample.
Try to position the probe about 100pm from the sample surface. As a guide
for your eye, note that the width of the shaft of the diamond tip is about
200pum.

Be careful not to get too close; ramming the tip into the sample can seriously damage your
transducer.

5.

10.

11.

Load the sample holder in the microscope as you would a standard holder for
your TEM.

Connect the transducer signal cable and piezo cable between the PI 95
Picolndenter and performech control unit. Cables should be routed to
prevent unnecessary strain and away from electrical devices such as
computer monitors to minimize interference.

Power on the performech control unit.

Start the TriboScan software.

Verify the tare value of the PI 95 Picolndenter by selecting the Calibration
tab = System Calibration sub tab and clicking the Update button near the

Tare Value parameter on the right side of the window.

Verify that the proper transducer calibration constants are entered in the
Calibration tab > System Calibration sub tab.

Run the Z-Axis Calibration as outlined in the Setup & Calibration chapter of
this user manual.
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Mechanical Testing

The general procedure used for performing an indentation test with the TEM

Picolndenter is outlined below:

1. Before performing a test both the sample and the probe must be located. DO
NOT attempt to adjust the probe location (except to retract, if desired)
unless the probe is visible-otherwise you risk ramming the probe into the
sample.

DO NOT attempt to adjust the probe location (except to retract, if desired) unless the probe is visible.
Attempting to do so may cause serious damage to the PicoIndenter.

2. Go to the XYZ Manipulation sub tab and move Z-Axis of the piezo element
to approximately 80% retracted. This will allow for more movement in the
forward Z-Axis direction when the sample test is ready to be performed.

3. Locate the very end of the probe and slowly approach the sample, using the
Z-Axis knob on the end of the TEM Picolndenter while simultaneously
using the TEM stage to track the probe movement. Continue approaching
until both the probe and the sample can be seen in the field of view.

4. Manually adjust the sample and probe heights: First set the sample height to
the eucentric height, then adjust the probe height using the manual control
knob so that it has the same focus as the sample (and therefore lies in the
same plane).

5. Using the piezo controls in the Load Function tab - XYZ Manipulation tab,
bring the probe close to the sample using Z, position laterally using X, and
adjust the probe height with Y (such that the probe and the sample are in
the same focus).

6. Choose a testing mode (open-loop, load control or displacement control)
from the Load Function tab = Quasi sub tab and setup the desired load
function.

7. Click the Zero button in the upper left of the TriboScan software.

8.  Click the Perform Indent button to run the test.
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Mechanical Testing

* The probe may jump when the system is toggled into load or displacement
control mode (when the feedback is enabled). Make sure the probe is not too
near the sample before enabling feedback to prevent the probe from hitting the
sample.

» Never use the manual axis controls when the feedback loop is enabled.
» Before you load the holder into the TEM, adjust the Y-axis height using the
manual axis control. Once inside the TEM it can be difficult to determine in

which direction to move the probe (up or down). Adjust the probe height such
that it is roughly in the center of the sample.
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Feedback Gain Settings

It is important, when testing with load or displacement controlled testing, to ensure
good feedback control during the indentation. There are several gains (located within
the Load Function window) to control but for most testing needs only a few of the

gains are used.

Default Gain Settings

Standard System
Integral Gain 1.0
Proportional Gain 0.0
Derivative Gain 0.0
Adaptive Gain 0.0
Lift Integral Gain 1.0

The Integral Gain has the biggest effect on the feedback controlled testing and will
determine how strongly the force or displacement signal will react to varying sample
properties. If the Integral Gain is too low, the force or displacement may not change
quickly enough when there is an error from the requested load. If the Integral Gain is
too high, the force may react too quickly to small changes caused by noise and

oscillations will begin to appear on the plot.

The Pre-Load Integral Gain setting is the integral gain setting during the drift
monitor time. The force is not changing during this hold, so the gain setting must be

lower to avoid oscillations. This is typically set at 0.2.

The Lift Integral Gain is the gain setting when the tip is in the air during the pre-
indent lift height movement or after the indent has come out of contact with the
sample at the end of the indentation. During these times, the stiffness of the contact is
much less, and there is no damping from the sample. As a result, the Lift Integral
Gain setting is typically about 10 times less than the Integral Gain during while in

contact with the sample.
In order to tune the gains for any particular sample a few practice indentations at

similar loads and loading rates should be run. The Integral Gain can then be

increased until oscillations occur. The Integral Gain should then be reduced by about

70 of 82



Ol
IS - YSITRON

Revision 9.2.1211

Feedback Gain Settings

30% for the best results. When the gains are tuned properly, the acquired data will
plot directly over the requested ramp on the real-time data plot. Examples of feedback

control real-time plots are given in Figure 4.14.

If large oscillations occur, due to improperly tuned gains, the displacement may exceed 5 pm and the
user may receive a Displacement Limit Exceeded error.

Suggestions for tuning the gains are given below.

* Try testing with the default gain settings first. The default gain setting
work well for most samples and typically require very little adjusting.

* In general, higher gains will increase noise-induced oscillations, and
lower gains will cause the displacement to deviate from the requested ramp.

» Keep the adaptive gain near zero. Larger values will cause oscillations
in most materials.

* Turn the proportional and derivative gains to zero to start. Use only the
adaptive gain and integral gain to force the displacement to follow the load
function then use the other gains to track small changes.

» Keep the derivative and proportional gains at a similar ratio when
changing them. The derivative gain will act as a stabilizing factor to damp
oscillations, but can also increase the effect of noise.

 If oscillations are observed at the point where the tip leaves the surface,
lower the Lift Integral Gain, as this causes the oscillations in the air.

* Slow the nanoindentation test down. In some very stiff metal samples,
the load has to change very quickly for a very small change in displacement. The
feedback loop may have a difficult time in ramping the force this quickly to
maintain the proper displacement rate so increasing the time will help.

Examples of incorrect gain settings for indentations on single crystal aluminum are

given in Figure 4.14.
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Feedback Gain Settings
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For displacement controlled nanoindentation tests, it is best to start tuning the gains
by running practice tests in the air. If the gains are tuned properly in the air, they will
be close to the correct settings on a sample. After setting the gains from the air tests
practice several nanoindentation tests on the sample, if possible, in order to fine tune

the feedback gains.

Displacement controlled testing has a program to assist the user in tuning the PID
gain settings. When a displacement controlled indentation has been selected from the
Load Function tab, an additional Tune PID Gains button will appear. Selecting the
Tune PID Gains button will open the PID Tuning window (Figure 4.15).

The PID Tuning window allows the user to modify and toggle the step response on
and off. When the step response is enabled a desired blue step response will appear in
the Step Response plot and a red (measured data) plot will appear over the plot. It is
desirable for the red and blue plots to follow closely (as shown in Figure 4.15). The
PID gains can be modified in real-time while the result continues to update on the
Step Response plot. When satisfied with the gain settings, click the Close button and
the software will prompt the user if they would like to save the current gain settings.

The gain setting will automatically be populated in the Load Function tab.
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‘\7'(: The desired gain settings are typically very near the default settings. Over-tuning the gains will cause
severe oscillations within the transducer and cause an emergency stop loop that requires a software
restart. Although the PID gains have slider bars that go from 0.0 up to 1000, the gains should be
adjusted slowly and monitored to prevent any sever oscillation.
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Indentation Analysis

Analysis performed with the PI 95 Picolndenter system is typically performed by
analyzing the indentation video in conjunction with the real-time indentation plot.
After each test, the system will prompt the user to save the file as a * hys file. * hys
files can be read by TriboScan from the Analysis tab = Quasi sub tab = Quasi sub
tab (Figure 5.1).

[ TriboScan Quasi J[=] B3
[Zeio ] Displ. () Actuationu)  Sample (uN) = Mods
oooos  |[oomo  |fosoos | { | L
2 [00000 1 [0.0000 |0.0000 ‘ @ Sicentaion

Analysis [ Load Function | Calibration | About

i

2800~ Cursor Pastion E ]

= 2800 L4
.
20 o &
§2‘W e oF Force (N) 000
& 200= B 2 Displacement (nm) 000
B "
a - 5

o = ah [Force Oifset ]

- &

1600~ o & [_ToogeGra_]

1400~ el A

= 2

1200- - ‘.-‘

1000~ i &

80— g g

- '4'
800~ - -
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o
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-
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Displacemnt (]

To open an existing ‘ * sys (Hysitron indentation file) click the Open icon at the top of

the window or select File > Open.

The Force Offset and Displ. Offset buttons allow the user to make any point on the
plot the origin. This is helpful in accounting for setpoint or lift height artifacts, or if
the test began with the probe out of contact with the sample surface. To use these

options, select a new point on the plot to be the zero force or zero displacement and

click either Force Offset and/or Displ. Offset.
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Enhanced Video Overlay

The enhanced video overlay functionality is one of the most important analysis tools
available to the Picolndenter system. TriboScan 9.2.12 (and above) incorporate the
video from the SEM/TEM system into the TriboScan software. In order to access the
video overlay functionality within TriboScan the test must be performed with the

Video Graphics toggle button (on the Load Function tab) switched to the On position.

The Video Graphics toggle switch must be set to On before performing the test in order for the user to
offline access to the video overlay features.

Previous versions of the video overlay used a blue screen overlay with a ‘virtual’ monitor and third
party frame grabber software. For information on upgrading your system to the enhanced video
overlay functionality contact a Hysitron service engineer.

During the test the Frame Grabber window may appear during the test and will
display the video that is captured during the test. Typically the system will be set up
to capture a video of the probe contacting the sample via one of the following

methods:

* VGA monitor splitter cable (with RCA out) and USB frame grabber
* Microscope BNC video output and USB frame grabber
» Ethernet frame grabber hardware and appropriate cabling

The hardware required will vary for each microscope and the frame grabber hardware

will be installed by the service engineer during the instrument installation.

The system will capture the standard *.Ays file and a *.avi file with the same file name
and the files will be saved in the same directory. The user can open the * Ays file or
the *.avi file independently for analysis or the two files can be opened in the same
window for analysis from the Analysis tab > Quasi sub tab > Frame Analysis sub

tab (Figure 5.2).
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Enhanced Video Overlay
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Within the Frame Analysis sub tab there are several viewing options as well as video

playback options.

The menu items (File and Image) to allow the user to save the indent and video as a
side-by-side an * avi movie, save the indent curve as an * avi movie, rotate the image,
and set an offset for the movie (to help sync the video with the indent curve if there is
a delay between the two systems). The delay can be minimized by starting with the
probe out of contact and synchronizing the start of the probe movement with the * ays

and *.qvi file.

There are three pull-down menus at the top of the Frame Analysis sub tab that allows
the user to choose the data to plot on the X and Y axes as well as a Current Frame
parameter at the bottom of the window that allows the user to set jump to a desired

frame.

There are multiple buttons under the video window that control the video. The
operation of these buttons (in order) are:

* Jump to start

* Back one frame
e Rewind

* Play backward
e Pause
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» Stop

* Play forward (normal play)

* Play between A and B markers

 Fast forward

* Forward one frame

e Jump to end

* Set A marker (for selective play between A and B)

* Set B marker (for selective play between A and B)

* Loop video

* Change video speed (down to 1/10x normal speed and up to 10x normal
speed)
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